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Understanding Breastfeeding: PowerPoint Class User Guide

■ Introduction
InJoy’s Understanding Breastfeeding PowerPoint Class curriculum provides comprehensive, evidence-based education about breastfeeding in the 
first six weeks and beyond, helping you deliver consistent information.

Featuring high-quality video clips, 3D latch animation, evidence-based content, and helpful educator notes, this fully customizable Understanding 
Breastfeeding PowerPoint Class allows you to have total teaching flexibility while covering the latest guidelines from the American Academy of 
Pediatrics (AAP), the International Lactation Consultant Association (ILCA), and other trusted organizations.

Presentation Overview

Chapters include:

1. Understanding How Breastfeeding Works — importance of breastfeeding, how your body makes milk, how your milk changes, special situations

2. Understanding Latching On & Positioning — getting off to the best start, skin-to-skin contact, breastfeeding positioning, effective latch,  
avoid pacifiers

3. Understanding When to Feed Your Baby  — hunger signs, feeding guidelines, sleepy eaters

4. Understanding Getting Enough Milk — signs of getting enough milk, minimum number of diapers, weight gain, warning signs

5. Understanding Breast Care — breast fullness, hand expression, engorgement, nipple care, nipple types, warning signs

6. Understanding Breastfeeding Lifestyle — AAP exclusive breastfeeding recommendation, partner support, substances to avoid, returning  
to work, expressing and storing milk, getting help

Let’s get started!

Step 1 Make sure your computer has the proper system requirements to view and customize this presentation 

Step 2 See our Quick Start Guide to quickly show the presentation 

Step 3 Learn how to customize this presentation 

Step 4 Get basic instructions on starting the presentation, moving through the slides, and showing the video clips 

Note: The PowerPoint images included in this guide are from PowerPoint 2013 unless otherwise indicated. If you are using PowerPoint 2007 or 2010, the general 
commands are the same, but you’ll notice that your menu bar looks slightly different. 
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■ PC System Requirements
Hardware:

• Computer with an optical (DVD) drive

• If you copy the presentation onto your computer, you’ll need approximately 1 GB of free space on your computer

• Projector, computer monitor, or TV to view the presentation (refer to your computer manual or your IT department for any extra adaptors that may 
be required for connecting to TVs or projectors)

• A printer is needed for printing handouts

Software:

• Microsoft Windows XP with Service Pack 3 (SP3), Windows Vista, or Windows 7 operating system (or later)

• To customize, you’ll need Microsoft Office PowerPoint 2007 (or later). If you do not have PowerPoint 2007 (or later), visit  
https://products.office.com/en-us/home to purchase

• To view the presentation without PowerPoint software, we recommend downloading the Microsoft PowerPoint Viewer (2010) found at  
https://www.microsoft.com/en-us/download/details.aspx?id=13 

■ Mac System Requirements
• We do not support running the video clip version of this presentation on a Mac. See FAQs on p. 7 for more information.

Step 1
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Figure B

■ Quick Start Guide
Here’s how to quickly show this presentation directly from the disc:

1. Insert the disc into your computer’s disc drive.
2. If you are connected to the internet, the disc will automatically load an easy-to-

use Quick Start Guide (Figure A). If you don’t have internet access, go to Step 5.

3. To open and view the presentation with PowerPoint 2007 or later, click on 
click here on Step 1 on the Quick Start Guide screen and then Open when 
prompted.

4. If you don’t have PowerPoint 2007 or later installed, click clicking here on 
Step 2 on the Quick Start Guide screen to download a free and safe version of 
PowerPoint Viewer. 

5. If the Quick Start Guide does not load automatically, click on the Windows Start 
menu and then My Computer (Figure B). Right click on the DVD drive and select 
Open (Figure C). Double click on the file labeled Start Here (Figure D). If you don’t 
have internet access, double click on the .pptx file.

Figure A

Note: If you are not customizing the presentation, you’re ready to go! Go to page 5 in 
this guide for more information on showing the presentation and playing video clips.

Step 2

Figure C

Figure D
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■ Customizing Your Presentation
You don’t have to be a PowerPoint pro, but it’s helpful to have some PowerPoint 
experience before customizing your presentation. To start, the presentation must be 
saved onto your computer before you can customize.

Saving the presentation onto your computer:
1. After inserting the disc into your disc drive, click on My Computer from the  

Start menu. (see Figure B in previous section)

2. Go to the DVD drive, right click, and select Copy. (Figure E)

3. Go to where you would like to store the folder, such as your desktop. Right click 
again and select Paste.

4. It may take several minutes to copy. Do not hit Escape or Cancel.

Customization instructions:
1. Open the folder that contains the presentation you just saved on your computer, 

and double click on the .pptx file to open the presentation.
2. To edit text, click on the View tab on the menu bar. Then, select Normal (Figure 

F). Edit text on slides as needed. 
3. To add your logo to the title slide, go to the title slide, click Insert on the menu 

bar and choose Picture (Figure G). Browse to locate a picture of your logo on 
your computer and double click to insert it onto the slide. You can then move it 
into your desired location and resize as needed. 

4. Want to change the order of slides? It’s easiest to move slides around in the 
Slide Sorter view. Click on the View tab on the menu bar. Then, select Slide 
Sorter (Figure H). Select the slide you’d like to move by clicking on it and 
dragging it to another section of the presentation. Note: It is not recommended that 
you cut and paste video clips alone, since doing so may remove the video trigger.  
Video clips will move with the slide.

5. Click Save as needed and before closing the presentation. Or, click Save As 
and enter a new name for your presentation if you wish to have both the original 
presentation and your customized one available. 

Figure E

Step 3

Figure F

Figure H

Figure G
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■ Showing & Navigating the Presentation
• Once you have opened your presentation with your version of PowerPoint 2007 

or later, press F5 on your keyboard to play the presentation from the beginning, or 
click on the slide show icon (Figure I) to play from the current slide. 

• Slides can be advanced by:

 » Clicking the mouse

 » Clicking on the forward arrow in the lower left-hand corner of the screen 

 » Pressing the SPACE BAR, PAGE DOWN, RIGHT ARROW, or ENTER

• You can move backwards by pressing PAGE UP or clicking on the left arrow in 
the lower left-hand corner of the screen

• To end the presentation, press ESCAPE or right-click and choose End Show

■ Playing Video Clips
The icon on a slide (Figure J) lets you know that there is a video clip associated 
with that slide. The clip name is also listed on the slide for your reference. The length 
of the clips is stated in the facilitator notes (see p. 6)

To play video clips:

• Simply click on the icon once.

• To pause the video, roll your mouse over the video to bring up the video player 
controls. Click on the pause icon. Click the play arrow to resume.

• To stop the video and return to the slide, press ESCAPE while the video  
is playing.

• After the video clip is finished, the video window will disappear and you will be 
returned to the current slide.

• On some slides you will be directed to play a video clip by clicking on individual 
photos (Figure K). Some of these clips will play full screen, and some will play 
within the slide. 

Step 4

Figure I

Figure J

Figure K
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■ Printing the Presentation
It may be helpful to have a printout of the presentation for quick reference as you 
teach or to hand out to your class. To print:

If you have PowerPoint 2013 or 2010:

1. Click on the File menu and choose Print. 
2. Go to Settings and click on Full Page Slides. (Figure L)
3. Select what you want to print from the drop-down menu. You can choose from 

slides, handouts, notes, and outline view. The Handouts (3 Slides per Page) 
option provides lines for taking notes.

If you have PowerPoint 2007:

1. If you have PowerPoint 2007, click on the Office button in the upper left corner, 
go to Print, and choose Print Preview.

2. Click on Print (Figure M)
3. Select what you want to print from the drop-down menu. You can choose from 

slides, handouts, notes, and outline view. The Handouts (3 Slides per Page) 
provides lines for taking notes.

■ PowerPoint Teaching Tips
• Review the facilitator notes for each slide. If you open the presentation in the 

PowerPoint application, the notes appear below the slide in Normal View. (Figure 
N) 

• If you also use Understanding Breastfeeding See What You Read Parent Guides,  
we’ve included page numbers in the facilitator notes and on the slides (bottom left 
corner) so that you and your students can reference the information in the booklet.

• Prior to using the presentation in class, practice presenting the slides and 
determine how long it takes for you to show the presentation. Become familiar with 
how the various slides build and how the video clips play.

• Before your class arrives, make sure the projector, screen, and speakers are 
working properly. Test by playing a video clip, and adjust your projector and 
speakers.

• Use a handheld wireless mouse or PowerPoint presenter remote during class to 
advance through the presentation. This allows you to move around, which is more 
engaging for your class than standing in one place.

Figure M

Figure N

Figure L

Facilitator Notes
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• As you present the slides, avoid reading the text verbatim. Instead, paraphrase and add your own insights to personalize your presentation.

• To keep your student’s interest, break up the PowerPoint presentation with interactive group exercises and games.

• Share our free Parent Handouts with your students. See below for download instructions.

■ Parent Handouts 
Go to http://injoyvideos.com/understanding-breastfeeding-powerpoint-class.html to download and print free Parent Handouts:

• Daily Breastfeeding Log

• How to Hand Express

• Parent Quiz

■ FAQs 
1. Q:  Why can’t I view the presentation or play videos on my computer?  

A:  If you don’t have PowerPoint 2007 or later, you need to download the recommended Microsoft PowerPoint Viewer (2010).  
Go to https://www.microsoft.com/en-us/download/details.aspx?id=13 to download. 

2.  Q:  I’m using a Mac. Will the presentation open in Keynote? 

A: No, this PowerPoint will not run in Keynote.

3. Q:  Is there a way to play video clips on my Mac?
A:  If you have Microsoft Office 2011 or later, you can download Flip4Mac to view video clips. Go to http://www.telestream.net/flip4mac/

download.htm for more information.

■ Still Need Help?
Our goal is to help you as much as we can. However, our Customer Care Team is not trained to answer advanced customization or technical 
questions beyond what is included in this guide. For more help, we recommend visiting https://support.office.com/en-us for free online PowerPoint 
training courses. For computer or other technical questions, consult with your facility’s IT department or system administrator. If you still need help, 
contact InJoy’s Customer Care Team at 800.326.2082.


